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Paper Set 1 · 29 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ଟ୍ରେ ନର ଗତି  ସହି ତ ସମାନ ଦି ଗରେ, ଟ୍ରେ ନ ଭି ତରେ ଆକାଶ 2 m/s ବେଗରେ ଗତି  କରୁ ଛି  ।
ଆଦି ତ୍ୟ ଟ୍ରେ ନର ବାହାରେ ଟ୍ରେ ନର ଦି ଗରେ 5 m/s ବେଗରେ ଧାଉଁ ଛି  । ଯଦି  ଟ୍ରେ ନର ବେଗ
7.2 km/hr ହୁ ଏ, ତେବେ ଆଦି ତ୍ୟଙ୍କ ସାପେକ୍ଷରେ ଆକାଶଙ୍କ ବେଗ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  1 m/s ପଛୁ ଆ

B.  9 m/s ପଛୁ ଆ

C.  6 m/s ପଛୁ ଆ

D.  4 m/s ପଛୁ ଆ

✓

Q2 Quant
₹135 ର ଏକ ନି ର୍ଦ୍ଧା ରି ତ ରି ହାତି  ପରେ ଏକ ସାର୍ଟ କୁ  ₹540 ରେ ବି କ୍ର ୟ କରାଗଲା । ତେବେ
ସାର୍ଟ ଟି ର ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟ କେତେ?

A.  ₹575

B.  ₹600

C.  ₹675

D.  ₹700

✓

Q3 Quant
ଜଣେ ବ୍ୟକ୍ତି  20 km/h ବେଗରେ 2 ଘଣ୍ଟା ଯାତ୍ରା  କରନ୍ତି , ତା’ପରେ 25 km/h ବେଗରେ 3
ଘଣ୍ଟା ଯାତ୍ରା  କରନ୍ତି  ଏବଂ ଶେଷରେ 30 km/h ବେଗରେ 1 ଘଣ୍ଟା ଯାତ୍ରା  କରନ୍ତି  । ଏହାପରେ
ସେ ସମଗ୍ର  ଯାତ୍ରା ର ହାରାହାରି  ବେଗରେ ନି ଜର ଯାତ୍ରା  ଜାରି  ରଖନ୍ତି  । ଉକ୍ତ ହାରାହାରି
ବେଗରେ 290 km ଦୂ ରତା ଅତି କ୍ର ମ କରି ବା ପାଇଁ  ତାଙ୍କୁ  କେତେ ସମୟ ଲାଗି ବ?

A.  10 ଘଣ୍ଟା

B.  11 ଘଣ୍ଟା

C.  12 ଘଣ୍ଟା

D.  13 ଘଣ୍ଟା

✓

Q4 Quant
ଦୁ ଇଟି  ସଂଖ୍ୟାର ଅନୁ ପାତ 7 : 9 ଏବଂ ସେଗୁ ଡି କର ଅନ୍ତର 24 ହେଲେ, ସଂଖ୍ୟା ଦୁ ଇଟି
ନି ର୍ଣ୍ଣ ୟ କର ।

A.  56 ଏବଂ 72

B.  63 ଏବଂ 87

C.  48 ଏବଂ 72

D.  84 ଏବଂ 108

✓

Q5 Quant
କେଉଁ  ବୃ ହତ୍ତମ ସଂଖ୍ୟା ଦ୍ଵାରା 80 ଓ 111 କୁ  ଭାଗ କଲେ ଭାଗଶେଷ ଯଥାକ୍ର ମେ 2 ଓ 7
ରହି ବ?

A.  18

B.  26

C.  32

D.  38

✓

Q6 Quant
ଏକ ସଂଖ୍ୟାର ଷଷ୍ଠାଂଶ ସହି ତ 18 ଯୋଗ କଲେ ତାହା ସଂଖ୍ୟାଟି ର ଚତୁ ର୍ଥାଂ ଶରୁ  12 ବି ୟୋଗ
କଲେ ମି ଳୁ ଥି ବା ଫଳାଫଳ ସହି ତ ସମାନ ହୁ ଏ । ସଂଖ୍ୟାଟି  ନି ର୍ଣ୍ଣ ୟ କର ।

A.  320

B.  340

C.  360

D.  380

✓

Q7 Quant
ଏକ ଶ୍ରେ ଣୀ ପ୍ର କଳ୍ପ ପାଇଁ  ମୋଟ 60 ଘଣ୍ଟାର କାର୍ଯ୍ୟ  ଆବଶ୍ୟକ । ଯଦି  5 ଜଣ ଛାତ୍ର  ମି ଳି ତ
ଭାବେ ଏହି  କାର୍ଯ୍ୟ କୁ  3 ଦି ନ ମଧ୍ୟରେ ସମ୍ପୂ ର୍ଣ୍ଣ  କରନ୍ତି , ତେବେ ପ୍ର ତ୍ୟେକ ଛାତ୍ର  ଦୈ ନି କ
କେତେ ଘଣ୍ଟା କାର୍ଯ୍ୟ  କରି ଥି ଲେ?

A.  4

B.  3

C.  5

D.  6

✓

Q8 Quant
ଯଦି  ଏକ ଭାରି ତ ମାଧ୍ୟମାନ ର ସମସ୍ତ ଭାର ସମାନ ହୁ ଏ, ତେବେ ଏହାର ଭାରି ତ ମାଧ୍ୟମାନ
କେତେ ଅଟେ?

A.  ହାର୍ମୋ ନି କ ମାଧ୍ୟମାନ

B.  ଏକ

C.  ଶୂ ନ

D.  ସମାନ୍ତର ମଧ୍ୟକ

✓

Q9 Quant
45 ର 30% ଠାରୁ  65 ର 30% କେତେ ଅଧି କ ଅଟେ?

A.  6

B.  1

C.  3

D.  8
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✓

Q10 Quant
A ଏବଂ B ଏକାଠି  କାମ କରି  ଗୋଟି ଏ କାର୍ଯ୍ୟ  4 ଦି ନରେ ଶେଷ କରି ପାରି ବେ । B ଏକାକୀ
ସମାନ କାର୍ଯ୍ୟ କୁ  20 ଦି ନରେ କରି ପାରି ବେ । A ଏକାକୀ କାମର ତି ନି ଗୁ ଣ କରି ବା ପାଇଁ
କେତେ ସମୟ (ଦି ନ ରେ) ନେବ?

A.  15

B.  30

C.  45

D.  60

✓

Q11 Quant
ଯଦି  ଦୁ ଇଟି  ସଂଖ୍ୟାର ଅନୁ ପାତ 6 : 7 ଏବଂ ସେମାନଙ୍କର ଗ.ସା.ଗୁ  46 ଅଟେ, ତେବେ
ସେମାନଙ୍କର ଲ.ସା.ଗୁ  କେତେ ହେବ?

A.  1932

B.  1954

C.  1935

D.  1982

✓

Q12 Quant
₹4,697 କୁ  ଏପରି  ତି ନି  ଭାଗରେ ବି ଭକ୍ତ କରାଯାଇଛି  ଯେ, ପ୍ର ଥମ ଭାଗର ଏକ-ଦ୍ୱି ତୀୟାଂଶ,
ଦ୍ୱି ତୀୟ ଭାଗର ଏକ-ଚତୁ ର୍ଥାଂ ଶ ଏବଂ ତୃ ତୀୟ ଭାଗର ଏକ-ଅଷ୍ଟମାଂଶ ସମାନ ଅଟେ । ପ୍ର ଥମ
ଏବଂ ଦ୍ୱି ତୀୟ ଭାଗ ମଧ୍ୟରେ ଥି ବା ଧନାତ୍ମକ ଅନ୍ତର (₹ ରେ) କେତେ?

A.  671

B.  521

C.  821

D.  721

✓

Q13 Quant
ବାର୍ଷିକ 16% ସୁ ଧ ହାରରେ 2 ବର୍ଷ  ପାଇଁ  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ପରି ମାଣର ମୂ ଳଧନର ସରଳ
ସୁ ଧ ଏବଂ ବାର୍ଷିକ ଭାବରେ ଚକ୍ର ବୃ ଦ୍ଧି  ହେଉଥି ବା ସୁ ଧ ମଧ୍ୟରେ ପାର୍ଥ କ୍ୟ ₹750 ଅଟେ ।
ମୂ ଳଧନ ନି ର୍ଣ୍ଣ ୟ କର । (ନି କଟତମ ଟଙ୍କାରେ ଉତ୍ତର ଦି ଅ)

A.  ₹29,297

B.  ₹29,288

C.  ₹29,293

D.  ₹29,277

✓

Q14 Quant
A, B, C ଏବଂ D ମଧ୍ୟରେ 6 : 3 : 5 : 4 ଅନୁ ପାତରେ ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ପରି ମାଣର ଅର୍ଥ
ବଣ୍ଟନ କରାଯି ବ । ଯଦି  D ଠାରୁ  A ₹2,000 ଅଧି କ ପାଏ, ତେବେ C ର ଅଂଶ କେତେ?

A.  ₹5,000

B.  ₹4,800

C.  ₹4,500

D.  ₹5,400

✓

Q15 Quant
ବାର୍ଷିକ ସରଳ ସୁ ଧ ହାର 9% ହେଲେ ମୂ ଳଧନ ₹3200 ରୁ  କେତେ ମାସରେ ₹360 ଟଙ୍କା
ସୁ ଧ ମି ଳି ବ?

A.  15

B.  12

C.  13

D.  19

✓

Q16 Quant
ଗୋଟି ଏ ସଂଖ୍ୟାକୁ  60% ବୃ ଦ୍ଧି  କଲେ ତାହା 3380 ହୁ ଏ । ତେବେ ସଂଖ୍ୟାଟି  ନି ର୍ଣ୍ଣ ୟ କର ।

A.  2112.5

B.  2225.2

C.  1056.7

D.  1337.8

✓

Q17 Quant
ଏକ ସାମଗ୍ରୀ  20% ଲାଭରେ ବି କ୍ରି   ହୁ ଏ । ଯଦି  ଉତ୍ପାଦନ ମୂ ଲ୍ୟ 10% ଏବଂ ବି କ୍ର ୟ ମୂ ଲ୍ୟ 5%
ବୃ ଦ୍ଧି  ପାଏ, ତେବେ ନୂ ତନ ଲାଭ ପ୍ର ତି ଶତରେ କେତେ ହେବ? (ଦଶମି କ ଗୋଟି ଏ ସ୍ଥାନ
ପର୍ଯ୍ୟ ନ୍ତ)

A.  13.7 %

B.  14.5 %

C.  15.6 %

D.  16.2 %

✓

Q18 Quant

ମନେକର ତ୍ରି  ଭୁ ଜ ABC ଏବଂ DEF ସଦୃ ଶ ଅଟେ । ଯଦି  ΔABC ର କ୍ଷେତ୍ର ଫଳ = 36 cm2,
ΔDEF ର କ୍ଷେତ୍ର ଫଳ = 81 cm2 ଏବଂ BC = 4.5 cm ହୁ ଏ, ତେବେ EF ନି ର୍ଣ୍ଣ ୟ କର ।

A.  3 cm

B.  4.15 cm

C.  5.5 cm

D.  6.75 cm
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✓

Q19 Quant
21 cm ବାହୁ  ବି ଶି ଷ୍ଟ ଏକ ସମଘନରେ ଗୋଟି ଏ ଗୋଲକ ଅନ୍ତର୍ଲିଖି ତ ହୋଇଛି  । ଗୋଲକର ପୃ ଷ୍ଠତଳ କ୍ଷେତ୍ର ଫଳ କେତେ?

(π= ବ୍ୟବହାର କରନ୍ତୁ)

A.  1,386 cm2

B.  1,848 cm2

C.  2,310 cm2

D.  3,234 cm2

✓

Q20 Quant

O କେନ୍ଦ୍ରବି ଶି ଷ୍ଟ ଏକ ବୃ ତ୍ତ ପ୍ର ତି  ଏକ ବାହ୍ୟ ବି ନ୍ଦୁ  A ରୁ  AB ଏବଂ AC ଦୁ ଇଟି  ସ୍ପର୍ଶ କ ଅଙ୍କି ତ ହୋଇଛି  । AO ରେଖାଖଣ୍ଡ BC ଜ୍ୟାକୁ  E ବି ନ୍ଦୁ ରେ ଛେଦ କରେ । ଯଦି  BE = , ତେବେ 

___________ ଡି ଗ୍ରୀ  ଅଟେ ।

A.  45

B.  90

C.  60

D.  120

GA

✓

Q21 GA
ଭାରତରେ ସ୍ୱାୟତ୍ତ ଶାସନ ପାଇଁ  କେଉଁ ଟି କୁ  ଚରମପନ୍ଥୀ ମାନେ ବି କଳ୍ପ ବୋଲି  ବି ଶ୍ୱାସ କରୁ
ନଥି ଲେ?

A.  ଶାନ୍ତି ପୂ ର୍ଣ୍ଣ  ଆନ୍ଦୋଳନ

B.  ବ୍ରି  ଟି ଶ ସାମରି କ ଶକ୍ତି  (British military strength)

C.  ଭଲ କି ମ୍ବା ନ୍ୟାୟଯୁ କ୍ତ ସରକାର (Good or just government)

D.  ଧାର୍ମିକ ବି ବି ଧତା (Religious diversity)

✓

Q22 GA
ଓଡ଼ି ଶାରେ ନ୍ୟାସନାଲ ଆଲୁ ମି ନି ୟମ କମ୍ପାନୀ ଲି ମି ଟେଡ (NALCO) କେଉଁ  ବର୍ଷ  ପ୍ର ତି ଷ୍ଠା
କରାଯାଇଥି ଲା?

A.  1971

B.  1989

C.  1978

D.  1981

✓

Q23 GA
FY 2025-26 ପାଇଁ  ଓଡ଼ି ଶାର ବାର୍ଷିକ ବଜେଟର ମୋଟ ବ୍ୟୟ କେତେ ଥି ଲା?

A.  ₹2,00,000 କୋଟି

B.  ₹2,50,000 କୋଟି

C.  ₹2,90,000 କୋଟି

D.  ₹3,00,000 କୋଟି

✓

Q24 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଆଗ୍ନେୟ ଶି ଳା ସୃ ଷ୍ଟି  କରୁ ଥି ବା ପ୍ର କ୍ରି  ୟାକୁ  ସର୍ବୋ ତ୍ତମ ଭାବରେ
ବର୍ଣ୍ଣ ନା କରେ?

A.  ସମୟାନୁ କ୍ର ମେ କ୍ଷୁ ଦ୍ର  ଖଣି ଜ କଣି କାମାନଙ୍କର ସଙ୍କୋଚନ

B.  ଜଳ ଏବଂ ପଥର ଖଣି ଜ ପଦାର୍ଥ  ମଧ୍ୟରେ ରାସାୟନି କ ପ୍ର ତି କ୍ରି  ୟା

C.  ତରଳ ପଦାର୍ଥ ର ଘନୀକରଣ

D.  ଅତ୍ୟଧି କ ତାପ ଏବଂ ଚାପ ହେତୁ  ରୂ ପାନ୍ତରଣ 

✓

Q25 GA
ଉଦ୍ଭି ଦ କୋଷରେ କେଉଁ  ପ୍ର କାରର ଲବକ ଆଲୋକଶ୍ଳେଷଣ ପାଇଁ  ଦାୟୀ ଅଟେ?

A.  ରଙ୍ଗୀନ ଲବକ

B.  ବର୍ଣ୍ଣ ହୀନ ଲବକ

C.  କ୍ଳୋରୋପ୍ଲା ଷ୍ଟ

D.  ଆମି ଲୋପ୍ଲା ଷ୍ଟ

✓

Q26 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ବି ଶ୍ୱତାପନ (Global Warming) ର ମୁ ଖ୍ୟ କାରଣ ଅଟେ ?

A.  ନବୀକରଣଯୋଗ୍ୟ ଶକ୍ତି ର ବର୍ଦ୍ଧିତ ବ୍ୟବହାର

B.  ଜଙ୍ଗଲ ଅବକ୍ଷୟ ଏବଂ ସବୁ ଜ କୋଠରୀ ଗ୍ୟାସ ନି ର୍ଗ ମନ

C.  ଓଜୋନ ସ୍ତରର କ୍ଷୟ

D.  ମହାସାଗରୀୟ ସ୍ରୋ ତରେ ପରି ବର୍ତ୍ତ ନ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q27 GA
ଅକ୍ଟୋବର 2025 ରେ 2025 UCI ଟ୍ରା କ୍  ସାଇକେଲିଂ  ବି ଶ୍ୱ ଚାମ୍ପି ଅନସି ପ୍  କେଉଁ  ଦେଶରେ
ଅନୁ ଷ୍ଠି ତ ହୋଇଥି ଲା?

A.  ଚି ଲି

B.  ଭାରତ

C.  ଇଣ୍ଡୋନେସି ଆ

D.  ଶ୍ରୀ ଲଙ୍କା

✓

Q28 GA
ଭାରତ ସଫଳତାର ସହ ନୂ ଆଦି ଲ୍ଲୀରେ 12 ତମ ବି ଶ୍ୱ ପାରା ଆଥଲେଟି କ୍ସ ଚାମ୍ପି ଅନସି ପ୍
2025 ଆୟୋଜନ କରି ଥି ଲା । ଭାରତ ପାଇଁ  ଏହି  ଇଭେଣ୍ଟର ମହତ୍ତ୍ୱ କ’ଣ ଥି ଲା?

A.  ପ୍ର ଥମ ଥର ପାଇଁ  ଭାରତ 30 ରୁ  ଅଧି କ ପଦକ ଜି ତି ଲା

B.  ପ୍ର ଥମ ଥର ପାଇଁ  ଭାରତ ବି ଶ୍ୱ ପାରା ଆଥଲେଟି କ୍ସ ଚାମ୍ପି ଅନସି ପ୍  ଆୟୋଜନ
କରି ଥି ଲା

C.  ଅରୁ ଣ ଜେଟଲି  ଷ୍ଟାଡି ୟମରେ ଏହି  କାର୍ଯ୍ୟ କ୍ର ମ ଅନୁ ଷ୍ଠି ତ ହୋଇଥି ଲା

D.  କେବଳ ପୁ ରୁ ଷ ଆଥଲେଟ ଅଂଶଗ୍ର ହଣ କରି ଥି ଲେ 

✓

Q29 GA
ନି ମ୍ନ ଲି ଖି ତ ଭାରତୀୟ ରାଜ୍ୟମାନଙ୍କ ମଧ୍ୟରୁ  କେଉଁ ଠାରେ 2025 'ଡ୍ରୋ ନ୍  କବଚ' (Drone
Kavach) ସମରାଭ୍ୟାସ ଅନୁ ଷ୍ଠି ତ ହୋଇଥି ଲା?

A.  ଅରୁ ଣାଚଳ ପ୍ର ଦେଶ

B.  ପଞ୍ଜାବ

C.  ମହାରାଷ୍ଟ୍ର

D.  ରାଜସ୍ଥାନ

✓

Q30 GA
2026 ମସି ହା ପ୍ରା ରମ୍ଭରେ ପ୍ର କାଶି ତ ପି ରି ଅଡି କ ଲେବର ଫୋର୍ସ  ସର୍ଭେ  (PLFS) ର ମାସି କ
ଆକଳନ ଅନୁ ଯାୟୀ, ଜାନୁ ଆରୀ 2026 ପାଇଁ  ଭାରତରେ ଆନୁ ମାନି କ ବେକାରୀ ହାର
କେତେ ଥି ଲା?

A.  3.5%

B.  5.0%

C.  7.5%

D.  9.0%

✓

Q31 GA
ଓଡ଼ି ଶାର କେଉଁ  ସ୍ଥାନ ଅକ୍ଟୋବର 2025 ରେ ଏହାର ଜଳଭାଗ ଉପରେ ଦୃ ଶ୍ୟମାନ
ହୋଇଥି ବା ଏକ ବି ରଳ "ହାତୀଆଶୁ ଣ୍ଢ" (Hatiasundha), (ବାତ୍ୟା ସଦୃ ଶ ଗଠନ) କାରଣରୁ
ଚର୍ଚ୍ଚା ରେ ଥି ଲା?

A.  ଅଂଶୁ ପା ହ୍ର ଦ

B.  ଚି ଲି କା ହ୍ର ଦ

C.  କାଞ୍ଜି ଆ ହ୍ର ଦ

D.  ସୋରଡା ଜଳଭଣ୍ଡାର

✓

Q32 GA
ବାୟୁ ମଣ୍ଡଳୀୟ ଗତି ବି ଜ୍ଞାନ (atmospheric dynamics) ରେ ଚାପ ପ୍ର ବଣତା ବଳ ର
ମୁ ଖ୍ୟ ଭୂ ମି କାକୁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସର୍ବୋ ତ୍ତମ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ?

A.  ଏହା ମାଧ୍ୟାକର୍ଷ ଣ ବଳ ହେତୁ  ସାମୁ ଦ୍ରି  କ ଜୁ ଆରର ନି ୟମି ତ ଉତ୍ଥାନ ଏବଂ ପତନକୁ
ନି ୟନ୍ତ୍ରଣ କରି ଥାଏ

B.  ଏହା ଉଚ୍ଚ ଚାପ ଅଞ୍ଚଳରୁ  ନି ମ୍ନ  ଚାପ ଅଞ୍ଚଳକୁ  ବାୟୁ ର ଆନୁ ଭୂ ମି କ ପ୍ର ବାହ ସୃ ଷ୍ଟି
କରି ଥାଏ

C.  ଏହା ପୃ ଥି ବୀର ଘୂ ର୍ଣ୍ଣ ନ ପରି ବେଗକୁ  ନି ୟନ୍ତ୍ରଣ କରେ ଏବଂ ଦି ନ-ରାତି  ଚକ୍ର କୁ  ବଜାୟ
ରଖେ

D.  ଏହା ଆଭ୍ୟନ୍ତରୀଣ ଭୂ -ଗତି ବି ଜ୍ଞାନ (geodynamic) ପ୍ର କ୍ରି  ୟା ଯଥା ଜ୍ୱାଳାମୁ ଖୀ
ଏବଂ ଭୂ କମ୍ପଜନି ତ କାର୍ଯ୍ୟ କଳାପକୁ  ସୃ ଷ୍ଟି  କରି ଥାଏ

✓

Q33 GA
ତି ନୋଟି  ପ୍ର ମୁ ଖ ଚି ରସ୍ରୋ ତା ନଦୀ ପ୍ର ଣାଳୀ— ସି ନ୍ଧୁ , ଗଙ୍ଗା ଓ ବ୍ର ହ୍ମପୁ ତ୍ର — ମୁ ଖ୍ୟତଃ କେଉଁ
ଉତ୍ସରୁ  ଜଳଧାରା ପାଇଥାନ୍ତି ?

A.  ଉଚ୍ଚ ହି ମାଳୟ ଅଞ୍ଚଳରେ ହି ମବାହ ଏବଂ ବରଫର ତରଳି ବାରୁ  ।

B.  ମୌସୁ ମୀ ବାୟୁ  ଦ୍ୱାରା ଅଣାଯାଇଥି ବା ଅତ୍ୟଧି କ ମୌସୁ ମୀ ବର୍ଷା ରୁ  ।

C.  ଶୀତଋତୁ ରେ ଘଟୁ ଥି ବା ବର୍ଷା ର ନି ୟମି ତ ଧାରାରୁ  ।

D.  ବି ଶାଳ ଭୂ ତଳ ଜଳଭଣ୍ଡାର ପ୍ର ଣାଳୀରୁ  ଜଳ ନି ର୍ଗ ମନ ହେବାରୁ  ।

✓

Q34 GA
86 ତମ ସାମ୍ବି ଧାନି କ ସଂଶୋଧନ ଅଧି ନି ୟମ, 2002 ଦ୍ୱାରା ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ମୌଳି କ
କର୍ତ୍ତ ବ୍ୟକୁ  ଭାରତୀୟ ସମ୍ବି ଧାନରେ ଯୋଗ କରାଯାଇଥି ଲା?

A.  ସର୍ବ ସାଧାରଣ ସମ୍ପତ୍ତି କୁ  ସୁ ରକ୍ଷା ପ୍ର ଦାନ କରି ବା

B.  ସଙ୍ଗତି  ଏବଂ ଭାତୃ ତ୍ଵକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା  

C.  ପ୍ରା କୃ ତି କ ପରି ବେଶର ସୁ ରକ୍ଷା ଏବଂ ଉନ୍ନତି କରଣ 

D.  6 ରୁ  14 ବର୍ଷ  ବୟସ୍କ ଶି ଶୁ ମାନଙ୍କ ପାଇଁ  ଶି କ୍ଷାଦାନର ସୁ ଯୋଗ ପ୍ର ଦାନ କରି ବା

✓

Q35 GA
ଏକ ଟ୍ରେ ନ 1.5 ଘଣ୍ଟାରେ ଉତ୍ତର ଦି ଗକୁ  60 km ଏବଂ ପରେ 1 ଘଣ୍ଟାରେ ଦକ୍ଷି ଣ ଦି ଗକୁ  40
km ଯାତ୍ରା  କରେ । ସମଗ୍ର  ଯାତ୍ରା ରେ ଏହାର ହାରାହାରି  ପରି ବେଗ କେତେ?

A.  ଘଣ୍ଟା ପ୍ର ତି  40 km

B.  ଘଣ୍ଟା ପ୍ର ତି  16 km

C.  ଘଣ୍ଟା ପ୍ର ତି  24 km

D.  ଘଣ୍ଟା ପ୍ର ତି  8 km

✓

Q36 GA
ନି ମ୍ନ ଲି ଖି ତ ଭାରତୀୟ ସାହି ତ୍ୟି କମାନଙ୍କ ମଧ୍ୟରୁ  କି ଏ ଗ୍ରା ମୀଣ ଜୀବନର ସଂଘର୍ଷ କୁ  ଆଧାର
କରି  ଲି ଖି ତ ଉପନ୍ୟାସ 'ଗୋଦାନ' ପାଇଁ  ସର୍ବା ଧି କ ପରି ଚି ତ?

A.  ରବୀନ୍ଦ୍ରନାଥ ଟାଗୋର

B.  ପ୍ରେ ମଚାନ୍ଦ

C.  ବଙ୍କି ମ ଚନ୍ଦ୍ର ଚଟୋପାଧ୍ୟାୟ

D.  ଆର. କେ. ନାରାୟଣ
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✓

Q37 GA
ଭାରତୀୟ ଶାସ୍ତ୍ରୀୟ ସଙ୍ଗୀତରେ ନି ମ୍ନ ଲି ଖି ତ ବାଦ୍ୟଯନ୍ତ୍ରଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  ସଠି କ
ଭାବରେ ତାର ବା ସୂ ତା ଉପକରଣ (ତତ ବାଦ୍ୟ) ଭାବରେ ବର୍ଗୀ କୃ ତ କରାଯାଇଛି ?

A.  ତବଲା

B.  ଶେହନାଇ

C.  ସୀତାର

D.  ମୃ ଦଙ୍ଗମ

✓

Q38 GA
ଦେଶର ମାନବ ବି କାଶ ସ୍ତର ମୂ ଲ୍ୟାଙ୍କନ ପାଇଁ  ସାଧାରଣତଃ କେଉଁ  ମାପକାଠି  ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  ମୋଟ ଘରୋଇ ଉତ୍ପାଦ

B.  ମୁ ଣ୍ଡପି ଛା ଆୟ

C.  ମାନବ ବି କାଶ ସୂ ଚକାଙ୍କ

D.  ଉପଭୋକ୍ତା ଦର ସୂ ଚକାଙ୍କ

✓

Q39 GA
19ତମ ଶତାବ୍ଦୀର ଓଡ଼ି ଶାରେ କେଉଁ  ଗୋଷ୍ଠୀ ପାଶ୍ଚାତ୍ୟ ଶି କ୍ଷା ଏବଂ ସାଂସ୍କୃତି କ ସଂସ୍କାରର
ବ୍ୟାପକ ପ୍ର ଚାର ଓ ପ୍ର ସାର କରି ଥି ଲେ?

A.  ପାରସ୍ୟ ବି ଦ୍ୱାନ

B.  ଆଦି ବାସୀ ବି ଦ୍ରୋ ହୀ ନେତା

C.  ମୋଗଲ ପ୍ରା ଦେଶି କ ଗଭର୍ଣ୍ଣ ର

D.  ଖ୍ରୀ ଷ୍ଟି ଆନ ମି ଶନାରୀ

✓

Q40 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ପ୍ର ତି କ୍ରି  ୟାଟି  ବି ସ୍ଥାପନ ପ୍ର ତି କ୍ରି  ୟାର ଏକ ଉଦାହରଣ ଅଟେ?

A.  NaOH + HCl → NaCl + H₂O

B.  Fe + CuSO₄ → FeSO₄ + Cu

C.  2H₂ + O₂ → 2H₂O

D.  CaCO₃ → CaO + CO₂

English

✓

Q41 English
Choose the correct option to fill in the blank.

Lex is ______ student at Don Bosco, Calcutta.

A.  a

B.  an

C.  the

D.  no article required

✓

Q42 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Mr. Gates’ highly impactful work on software shaped the field of computer science.

A.  conspicuous

B.  seminar

C.  seminal

D.  inconsequential

✓

Q43 English
Choose the correct proverb to substitute the underlined word segment in the following sentence.

After being deceived in business once, Raghav now hesitates to trust new partners because he learned his lesson the hard way.

A.  was given a taste of his own medicine

B.  believed that every cloud has a silver lining

C.  was once bitten, and is now twice shy

D.  was caught between a rock and a hard place
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✓

Q44 English
Choose the correct proverb to substitute the underlined word segment in the following sentence.

After hours of negotiation, both sides finally agreed that the proposal was reasonable and not worth arguing over.

A.  a bargain is a battle half won

B.  a friend in need is a friend indeed

C.  a fair offer is no cause of feud

D.  the customer is always right

✓

Q45 English
Select the correct passive voice form of the given sentence.

Someone had cleaned the room before we arrived.

A.  The room was being cleaned before we arrived.

B.  The room has been cleaned before we arrived.

C.  The room is cleaned before we arrived.

D.  The room had been cleaned before we arrived.

✓

Q46 English
Choose the correct form of future tense for the given sentence.

I exercised vigorously yesterday morning.

A.  I exercise vigorously every morning.

B.  I will exercise vigorously everyday from tomorrow.

C.  I had exercised vigorously yesterday morning.

D.  I am exercising vigorously now.

✓

Q47 English

Read the passage and answer the questions that follow.

On 11 July 1987, the global population touched the 5 billion mark. To spread awareness about population-related issues, the then-Governing
Council of the United Nations Development Programme in 1989 decided to observe 11 July as World Population Day. The day was first marked in
1990 across 90 countries. The number of people living in a particular city, town or country constitutes its population. By 2050, the world
population could be around 9.8 billion. However, we may reach the mark even earlier, due to the health-care crisis precipitated by the coronavirus
pandemic and the subsequent lockdown. With a population of 1.3 billion or 130 crore, India is the second most populous country in the world,
next to China. On World Population Day, this primer looks at the factors that affect population growth, the impact of COVID-19 crisis on
population control measures and why we need to fight population explosion, sooner than later.

Identify the suitable title for the passage.

A.  The Development of Urban Forests

B.  The History of International Trade

C.  The Growth of World Population

D.  The Expansion of Modern Technology
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✓

Q48 English
Identify the central theme of the passage.

A.  Rise of global entertainment media

B.  Need for population control awareness

C.  Benefits of industrial expansion

D.  Decline of global healthcare systems

✓

Q49 English
What inference can be drawn from the passage?

A.  Education is unrelated to population growth

B.  Wildlife populations are increasing fast

C.  Technology alone solves population issues

D.  Population growth requires urgent attention

✓

Q50 English
What is the tone of the passage?

A.  Sarcastic and mocking

B.  Informative and cautionary

C.  Joyful and celebratory

D.  Romantic and emotional

✓

Q51 English
Choose the antonym of the word growth as used in the passage.

A.  Expansion

B.  Increase

C.  Progress

D.  Decline

✓

Q52 English
Select the most appropriate option to fill in the blank.
She completed her assignment ___, making sure there were no spelling or grammar mistakes.

A.  quickly

B.  slowly

C.  carefully

D.  loudly
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✓

Q53 English
Read the following sentence and identify the option with the misspelt word.
The affordabiliity of hand phones has increased due to the prepaid system.

A.  affordabiliity

B.  increased

C.  system

D.  prepaid

✓

Q54 English
Select the most appropriate ANTONYM of the highlighted word.

The manager tried to diminish the team's concerns during the meeting.

A.  reduce

B.  amplify

C.  intervene

D.  decrease

✓

Q55 English
A statement is divided into different segments. The first segment (A) is fixed. Rearrange the remaining segments to make a meaningful
sentence.

A) active volcanoes
B) throwing hot ash
C) can erupt suddenly
D) during a massive explosion
E) into the atmosphere

A.  A B C E D

B.  A D E C B

C.  A C B E D

D.  A E C B D

✓

Q56 English
Choose the most appropriate antonym of the underlined word from the options given below.
The ruler was known for his despotic manner, allowing no room for dissent or opposition.

A.  tactful

B.  regal

C.  democratic

D.  autocratic
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✓

Q57 English
Choose the option which converts the following into indirect speech.

"I must leave now, or I will miss the last train," said Arthur.

A.  Arthur said that he must leave then or he would miss the last train.

B.  Arthur said that he had to leave then or he would miss the last train.

C.  Arthur said that he had to leave now or he would miss the last train.

D.  Arthur said that he must have left then or he would have missed the last train.

✓

Q58 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Called behavioural ecology, it starts from the idea or theory on which the explanation is based—that social and environmental forces select for
various behaviours that optimise people's fitness in a given environment.

A.  franchise

B.  archive

C.  premise

D.  promise

✓

Q59 English
Complete the sentence with the grammatically appropriate verb form.

The committee will ___ the proposal after thoroughly reviewing all the data.3938

A.  be finalize

B.  have finalize

C.  finalizes

D.  finalize

✓

Q60 English
Choose the correct option to form a meaningful sentence using the anchor segment, which is to be used at the end.
Anchor segment: as if he had never seen it before.

1. the magician
2. reacted
3. to his own trick
4. dramatically

A.  1 – 4 – 2 – 3

B.  2 – 1 – 4 – 3

C.  1 – 2 – 3 – 4

D.  4 – 1 – 2 – 3
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Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ମନ ____ ରହି ଲେ ସବୁ  କାର୍ଯ୍ୟ  ସଠି କ ରୂ ପରେ ସମ୍ପନ୍ନ ହୁ ଏ ।''

A.  ତରତର

B.  ଦୟାରେ

C.  ମନ୍ଦମନ୍ଦ

D.  ଶାନ୍ତି ରେ

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The bowler delivered six perfect balls in the over.

A.  ବୋଲର ଏକ ଓଭରରେ ଉତ୍ତମ ଛ'ଟି  ବଲ ଫି ଙ୍ଗି ଥି ଲେ।

B.  ବୌଲର ଓଭର ଛଅ ବଲ ଫେଙ୍ଗି ଲେ।

C.  ବୌଲର ଓଭରରେ ସଠି କ ବଲ ଫେଙ୍ଗି ଛନ୍ତି ।

D.  ବୌଲର ଛଅଟି  ଓଭରରେ ବଲ ଫେଙ୍ଗି ଥି ଲେ।

✓

Q63 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ବି ପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଶୁ ଖି ଲା

A.  କଞ୍ଚା

B.  ଆଦ୍ର

C.  ପତ୍ର

D.  ଗଛ

✓

Q64 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ମାନବ

A.  ମନୁ ଷ୍ୟ

B.  ପଶୁ

C.  ଦାନବ

D.  ଦୈ ତ୍ୟ

✓

Q65 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ତୁ ମ ଗାଁ  ର ପ୍ର ଥମ ସରପଞ୍ଚ କି ଏ ଥି ଲେ ?

A.  Who was the first Sarpanch of your village?

B.  Who are the first Sarpanch of your village?

C.  Who will be the first Sarpanch of your village?

D.  Who was the Sarpanch of your village?
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✓

Q66 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ଗତ ମାସରେ, ଯେତେବେଳେ ଆମେ ହାଇଦ୍ରା ବାଦ ଯାଇଥି ଲୁ , ହଠାତ୍  ଆମର ଜଣେ ପି ଲାଦି ନର ବନ୍ଧୁ ଙ୍କୁ  ଭେଟି ଲୁ ।

A.  Last month, when we visited Hyderabad, we suddenly met one of childhood friends of ours.

B.  Last month, when we were visiting Hyderabad, we met one of our childhood friend.

C.  Last month, when we were visiting Hyderabad, we suddenly met one of my friends.

D.  Last month, when we were visiting Hyderabad, we met a friend .

✓

Q67 Odia
ଦି ଲୀପ ଭଲ ଖେଳୁ ଛି , କି ନ୍ତୁ ପଢୁ ନି ।ଏହି  ବାକ୍ୟରେ ଥି ବା ଅବ୍ୟୟ ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  ଦି ଲୀପ

B.  କି ନ୍ତୁ

C.  ଭଲ

D.  ଖେଳୁ ଛି

✓

Q68 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  "ଦାତା" ଶଦ୍ଦର ବି ପରୀତ କି ଏ ?

A.  ଭୋକ୍ତା

B.  ଗ୍ରା ହ୍ୟ

C.  ଗ୍ର ହୀତବ୍ୟ

D.  ଗ୍ର ହୀତା

✓

Q69 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦକୁ  ପାଠ କରି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ବାଛ ।
ମାନବ ସମାଜ ଆଜି  ବି କାଶର ଚରମ ସୋପାନରେ ଉପନୀତ । ବି ଜ୍ଞାନର ଅବି ଶ୍ଵାସନୀୟ ଅଗ୍ର ଗତି  ଫଳରେ ମାନବ ସଭ୍ୟତା ଆଜି  ନୂ ତନ ଦି ଗକୁ  ଛୁ ଇଁ  ପାରି ଛି  । ନବ ସଭ୍ୟତା ଯେତେ ଯେତେ ଆଗକୁ
ଯାଉଛି  ଆମେ ସେତେ ସତେ ଆମ ପରମ୍ପରା ଓ ଐତି ହ୍ୟକୁ  ପାଶୋରି ବାରେ ଲାଗି ଛେ । ପ୍ରା ଚୁ ର୍ଯ୍ୟ ର ଆଲୋକ ଆମ ସାମ୍ନା ରେ ଏମି ତି  ଭେଳି କି  ଲଗାଇ ଦେଇଛି  ଯେ, ଆମ ଆଖ ପାଖର ମଣି ଷମାନଙ୍କୁ
ଆମେ ଏବେ ଅବହେଳା କରି ବାରେ ଲାଗି ଛେ । ତେଣୁ  ଏହି  ପ୍ର ବାଦଟି  ମନେ ପକାଇବା ଉଚି ତ ଯେ -'ଦୀପତଳ ଅନ୍ଧାର' । ଦୀପର ଧର୍ମ  ହେଉଛି  ଅନ୍ୟକୁ  ଆଲୋକ ପ୍ର ଦାନ କରି  ସମାଜର କଲ୍ୟାଣ
ସାଧନ କରି ବା । କି ନ୍ତୁ ପ୍ର ଦୀପର ଆଲୋକରେ ତା'ର ଚାରି ପାଖ ଆଲୋକି ତ ହେଉଥି ବା ବେଳେ ଏହାର ତଳ ପାଖ ଅନ୍ଧାରରେ ରହି ଥାଏ । ସେଥି ପାଇଁ  କୁ ହାଯାଇଛି -'ଦୀପତଳ ଅନ୍ଧାର' । ଏହି  ପ୍ର ବାଦଟି କୁ
ଆଲୋଚନା କଲେ ଜଣାଯାଏ ଯେ ସଭ୍ୟତାର ବି କାଶ ଚରମସୀମା ଛୁ ଇଁ ଥି ଲେ ହେଁ  ଅନ୍ଧବି ଶ୍ଵାସର ଚଉହଦି ରେ ଅନେକ ଛୋଟ ଛୋଟ ଜି ନି ଷ ଲୁ ଚି  ରହି  ସମାଜରେ ଅଶେଷ କ୍ଷତି  ଘଟାଇ ଥାଏ ।
ସେହି ପରି  ସମଗ୍ର  ବି ଶ୍ଵରେ ଯୁ କ୍ତରାଷ୍ଟ୍ର ଆମେରି କା ସବୁ  କ୍ଷେତ୍ର ରେ ଅଗ୍ର ଣୀ ହେଲେ ହେଁ  ସେଠାରେ ମଧ୍ୟ ଦୁ ର୍ନୀ ତି ,ଗରି ବୀ ଓ ବର୍ଣ୍ଣ ବୈ ଷମ୍ୟ ଭଳି  ସମସ୍ୟା ରହି ଛି  ଯାହା ବି ଶ୍ଵବ୍ୟାପୀ ଅପନି ନ୍ଦାର ଖୋରାକ
ଯୋଗାଇଥାଏ ଏବଂ 'ଦୀପତଳ ଅନ୍ଧାର' ଭଳି  ଲାଗେ ।

ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ବି କାଶର ଚରମ ସୋପାନ' ବାକ୍ୟର ସବୁ ଠାରୁ  ଉପଯୁ କ୍ତ ଅର୍ଥ  କଣ ?

A.  ଆରମ୍ଭ ଅବସ୍ଥା

B.  ସାଧାରଣ ଅବସ୍ଥା

C.  ଅବନତି ର ଅବସ୍ଥା

D.  ସର୍ବୋ ଚ୍ଚ ଉନ୍ନତି  ସ୍ଥର
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✓

Q70 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ପରମ୍ପରା ଓ ଐତି ହ୍ୟକୁ  ପାଶୋରି ବା'ର ଅର୍ଥ  କଣ ?

A.  ସମ୍ମାନ କରି ବା

B.  ରକ୍ଷା କରି ବା

C.  ଅବହେଳା କରି ବା

D.  ପ୍ର ଚାର କରି ବା

✓

Q71 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ଦୀପତଳ ଅନ୍ଧାର' ପ୍ର ବାଦଟି  କେଉଁ  ପରି ସ୍ଥି ତି କୁ  ବୁ ଝାଏ ?

A.  ସମସ୍ତେ ଖୁ ସି  ଥି ବା ଅବସ୍ଥା

B.  ନି କଟର ଅସୁ ବି ଧାକୁ  ଅଣଦେଖା କରି ବା

C.  ଦୂ ରରେ ଥି ବା ଘଟଣାକୁ  ଦେଖି ବା

D.  ସମସ୍ତଙ୍କୁ  ସାହାଯ୍ୟ କରି ବା

✓

Q72 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ବର୍ଣ୍ଣ ବୈ ଷ୍ଣବ' ଶଦ୍ଦଟି  କାହାକୁ  ସୁ ଚାଏ ?

A.  ଶି କ୍ଷାର ଅଭାବ

B.  ଧନ-ସମ୍ପତ୍ତି ର ଅଭାବ

C.  ଚର୍ମ ରଙ୍ଗ ଆଧାରି ତ ଭେଦଭାବ

D.  ଭାଷାର ପାର୍ଥ କ୍ୟ

✓

Q73 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ବି ଜ୍ଞାନର ଅଗ୍ର ଗତି ' ବାସ୍ତବ ଜୀବନରେ କଣ ସୁ ଚାଏ ?

A.  ନୂ ତନ ସଂସ୍କୃତି  ଗଢି ବା

B.  ଅନ୍ଧବି ଶ୍ଵାସ ବଢି ବା

C.  ପରମ୍ପରାର ନାଶ

D.  ମାନବ ସଭ୍ୟତାର ଉନ୍ନତି

✓

Q74 Odia
ଜ୍ଞାନୀ ଲୋକ ସମ୍ମାନ ଲାଭ କରନ୍ତି  । ଏହି  ବାକ୍ୟରେ 'ଜ୍ଞାନୀ' କେଉଁ  ପ୍ର କାରର ବି ଶେଷଣ ?

A.  ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  ପରି ମାଣବାଚକ ବି ଶେଷଣ

C.  ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

D.  ସୂ ଚନାବାଚକ ବି ଶେଷଣ

✓

Q75 Odia
"ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକୀୟ ସାମଗ୍ରୀ  ଆଣ" ଏହି  ବାକ୍ୟର ଶୁ ଦ୍ଧ ରୂ ପ କଣ ହେବ?

A.  ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକ ସାମଗ୍ରୀ  ଆଣ ।

B.  ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକୀୟା ସାମଗ୍ରୀ  ଆଣ ।

C.  ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକତା ସାମଗ୍ରୀ  ଆଣ ।

D.  କୌଣସି ଟି  ନୁ ହେଁ  ।
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Computer

✓

Q76 Computer
ମାଇକ୍ରୋ ସଫ୍ଟ  ୱାର୍ଡ ରେ କେଉଁ  କୀବୋର୍ଡ  ସର୍ଟ କଟ ଆପଣଙ୍କୁ  ମାଉସ ବ୍ୟବହାର ନକରି  ସମ୍ପୂ ର୍ଣ୍ଣ
ପାରାଗ୍ରା ଫ ସି ଲେକ୍ଟ କରି ବା ପାଇଁ  ଅନୁ ମତି  ଦେବ?

A.  Ctrl + Shift + Right Arrow

B.  Ctrl + Shift + Down Arrow

C.  Ctrl + A

D.  Ctrl + Shift + Up Arrow

✓

Q77 Computer
MS ଏକ୍ସେଲ 2021 ରେ ଡାଟାକୁ  ବର୍ଣ୍ଣା ନୁ କ୍ର ମି କ କି ମ୍ବା ସଂଖ୍ୟାତ୍ମକ ଭାବରେ ବ୍ୟବସ୍ଥି ତ କରି ବା
ପାଇଁ  କେଉଁ  କମାଣ୍ଡ ବ୍ୟବହାର କରାଯାଏ?

A.  Sort

B.  Arrange

C.  Align

D.  Filter

✓

Q78 Computer
ଏକ ସ୍ଲା ଇଡରେ ଏକ ଭି ଡି ଓ କି ମ୍ବା ଅଡି ଓ ଇନସର୍ଟ  କରି ବା ପାଇଁ  କ'ଣ କରି ବାକୁ  ପଡି ଥାଏ?

A.  Insert → Media

B.  Design → Layout

C.  Review → Add Clip

D.  View → Multimedia

✓

Q79 Computer
ଇମେଲ କମ୍ୟୁ ନି କେଶନରେ ରି ପଲାଏ (Reply) ଏବଂ ଫରୱାର୍ଡ  (Forward) ମଧ୍ୟରେ
ପାର୍ଥ କ୍ୟ କ’ଣ?

A.  Reply ନୂ ତନ ରେସି ପେଣ୍ଟଙ୍କୁ  ମେସେଜ ପଠାଇଥାଏ; Forward ସେଣ୍ଡରଙ୍କୁ  ରି ପ୍ଳାଏ
କରି ଥାଏ ।

B.  Reply ମୂ ଳ ସେଣ୍ଡରଙ୍କୁ  ରେଶପଣ୍ଡ କରି ଥାଏ; Forward ଅନ୍ୟ ଜଣେ
ରେସି ପେଣ୍ଟଙ୍କୁ  ମେସେଜ ପଠାଇଥାଏ ।

C.  ଉଭୟ ଇମେଲ ଥ୍ରେ ଡରେ ସମସ୍ତଙ୍କୁ  ରେଶପନ୍ସ  ସେଣ୍ଡ କରନ୍ତି  ।

D.  Forward ମୂ ଳ ମେସେଜକୁ  ସ୍ୱୟଂଚାଳି ତ ଭାବରେ ଡି ଲି ଟ କରି ଥାଏ ।

✓

Q80 Computer
ପାୱାର ପଏଣ୍ଟ (MS ପାୱାରପୋଏଣ୍ଟ 2021) ବ୍ୟବହାର କରି ବା କଣ୍ଟେକ୍ସଟ ରେ ସ୍ତମ୍ଭ A ର
ବେସି କ ଫଙ୍କସନକୁ  ସ୍ତମ୍ଭ B ର ସଠି କ ଡେସକ୍ରି  ପସନ ସହି ତ ମେଳ କରନ୍ତୁ ।

ସ୍ତମ୍ଭ A ସ୍ତମ୍ଭ B

1. ସ୍ଲା ଇଡ ଶୋ
ମୋଡ

a) ସ୍ଲା ଇଡ ଏଲି ମେଣ୍ଟରେ ଭି ଜୁ ଆଲ ଇଫେକ୍ଟସ ଏବଂ ଟ୍ରା ଞ୍ଜି ସନ୍ସ  ଆପ୍ଲା ଏ
କରେ

2. ଡି ଜାଇନ
ଟ୍ୟାବ

b) ପ୍ରେ ଜେଣ୍ଟେସନ ଉଦ୍ଦେଶ୍ୟରେ ପ୍ରେ ଜେଣ୍ଟେସନକୁ  ଫୁ ଲ୍ -ସ୍କ୍ରି ନ୍  ଭ୍ୟୁ
ରେ ଡି ସପ୍ଲେ  କରେ

3. ଆନି ମେସନ
ଟ୍ୟାବ

c) ସ୍ଲା ଇଡ ଥି ମ୍ସ , ବ୍ୟାକଗ୍ରା ଉଣ୍ଡ ଫର୍ମା ଟ୍ସ , ଆଣ୍ଡ କଲର ଭେରି ଏସନ୍ସ
ପ୍ର ଦାନ କରେ

4. ଇନସର୍ଟ
ଟ୍ୟାବ

d) ଇମେଜେସ, ଚାର୍ଟ , ସେପ୍ସ, ଏବଂ ଟେକ୍ସଟ ବକ୍ସ ପରି  କଣ୍ଟେଣ୍ଟ ଆଡ
କରି ବାକୁ  ସକ୍ଷମ କରେ

A.  1–b, 2–c, 3–a, 4–d

B.  1–a, 2–d, 3–b, 4–c

C.  1–c, 2–b, 3–d, 4–a

D.  1–d, 2–a, 3–c, 4–b

✓

Q81 Computer
କମ୍ପ୍ୟୁ ଟରର ପାୱାର ସେଭିଂ  ମୋଡ ବି ଷୟରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସଠି କ ଅଟେ?

A.  ସ୍କ୍ରି ନ କୁ  ବ୍ରା ଇଟ କରେ (Brightens the screen)

B.  ସ୍କ୍ରି ନ କୁ  କ୍ଲି  ଅର କରେ (Clears the screen)

C.  ସ୍କ୍ରି ନ କୁ  ଶାର୍ପ  କରେ (Sharpens the screen)

D.  ସ୍କ୍ରି ନ କୁ  ଡି ଙ୍ଗ କରେ (Dinges the screen)

✓

Q82 Computer
ସାଧାରଣ କମ୍ପ୍ୟୁ ଟର ବ୍ୟବହାର ସମୟରେ ସି ଧାସଳଖ ଦେଖା ନ ଗଲେ ମଧ୍ୟ ନି ମ୍ନ ଲି ଖି ତ
କେଉଁ ଟି କୁ  ସି ଷ୍ଟମ ସଫ୍ଟ ୱେର ଭାବରେ ବି ବେଚନା କରାଯାଏ?

A.  ଟେକ୍ସଟ ଏଡି ଟର

B.  ବୁ ଟଲୋଡର

C.  ସ୍ପ୍ରେଡଶି ଟ

D.  ମି ଡି ଆ ପ୍ଲେ ୟାର

✓

Q83 Computer
କେଉଁ  ବି ଲ୍ଟ -ଇନ ୱି ଣ୍ଡୋଜ 11 ଫି ଚର ୟୁ ଜରଙ୍କୁ  ସି ଷ୍ଟମ ଫାଇଲ ଏବଂ ସେଟିଂ ସକୁ  ପୂ ର୍ବ  ସମୟ
(earlier point) କୁ  ରି ଭର୍ଟ  କରି ବାରେ ସକ୍ଷମ କରେ?

A.  ଡି ସ୍କ କ୍ଲି  ନଅପ

B.  ସି ଷ୍ଟମ ରି ଷ୍ଟୋର

C.  ଟାସ୍କ ସେଡ୍ୟୁ ଲର

D.  ଇଭେଣ୍ଟ ଭ୍ୟୁ ଅର
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✓

Q84 Computer
MS ପାୱାରପଏଣ୍ଟ ରେ କେଉଁ  ଭି ୟୁ  ଜଣେ ୟୁ ଜରଙ୍କୁ  ସମଗ୍ର  ପ୍ରେ ଜେଣ୍ଟେସନର ଏକ ବ୍ୟାପକ
ସାରାଂଶ (comprehensive overview) ପ୍ର ଦାନ କରି ବା ସହି ତ ସ୍ଲା ଇଡ କଣ୍ଟେଣ୍ଟ ଏଡି ଟ
କରି ବା, ସ୍ଲା ଇଡ ପୁ ନର୍ଗ ଠନ (rearrange) କରି ବା ଏବଂ ଆନି ମେସନ ଆପ୍ଳାଏ କରି ବା ପାଇଁ
ଅନୁ ମତି  ଦି ଏ?

A.  ସ୍ଲା ଇଡ ସର୍ଟ ର ଭି ୟୁ

B.  ନର୍ମା ଲ ଭି ୟୁ

C.  ରି ଡି ଙ୍ଗ ଭି ୟୁ

D.  ଆଉଟଲାଇନ ଭି ୟୁ

✓

Q85 Computer
MS ଏକ୍ସେଲରେ 'General' ଫର୍ମା ଟ ବ୍ୟବହାର କରି ବାର ଉଦ୍ଦେଶ୍ୟ କ'ଣ?

A.  କେବଳ ଟେକ୍ସଟ ଡି ସପ୍ଲେ  କରି ବା

B.  କରେନ୍ସି   ଫର୍ମା ଟିଂ  ଆପ୍ଳାଏ କରି ବା (To apply currency formatting)

C.  ଆପଣ ଏକ ନମ୍ବର ଟାଇପ କରି ବା ସମୟରେ Excel ଆପ୍ଳାଏ କରୁ ଥି ବା ଡି ଫଲ୍ଟ
ନମ୍ବର ଫର୍ମା ଟ ସି ଲେକ୍ଟ କରି ବା

D.  ବୈ ଜ୍ଞାନି କ ସଙ୍କେତରେ ଲାର୍ଜ  ନମ୍ବର ଡି ସପ୍ଲେ  କରି ବା (To display large
numbers in scientific notation)

✓

Q86 Computer
ଏକ ଇ-ମେଲ ର ବଡି  କେଉଁ  କ୍ୟାରେକ୍ଟର ସି କ୍ୱେନ୍ସ  ଦ୍ୱାରା ଏହାର ହେଡରରୁ  ପୃ ଥକ
ହୋଇଥାଏ?

A.  ସି ଙ୍ଗଲ ନି ଉ ଲାଇନ (Single newline)

B.  ଡବଲ ନି ଉ ଲାଇନ (Double newline)

C.  ସେମି କୋଲନ (Semicolon)

D.  କମା (Comma)

✓

Q87 Computer
ଏକ ଷ୍ଟାଣ୍ଡାର୍ଡ  CD (କମ୍ପ୍ୟାକ୍ଟ ଡି ସ୍କ) ର ମୂ ଳ ଷ୍ଟୋରେଜ କାପାସି ଟି  କେତେ ଥି ଲା?

A.  650-700 MB

B.  1.44 MB

C.  4.7 GB

D.  100 MB

✓

Q88 Computer
ଆପଣ MS ୱାର୍ଡ ରେ ଏକ ନୂ ଆ ବ୍ଳା ଙ୍କ ଡକ୍ୟୁ ମେଣ୍ଟ କି ପରି  ସୃ ଷ୍ଟି  କରି ବେ?

A.  Home tab > New

B.  File tab > New > Blank Document

C.  Insert tab > New

D.  View tab > New

✓

Q89 Computer
MS ୱାର୍ଡ ରେ ବାମ ପାର୍ଶ୍ୱ ରେ ଥି ବା କ୍ୟାରେକ୍ଟର ଗୁ ଡ଼ି କୁ  ହଟାଇବା ପାଇଁ  ସର୍ଟ କଟ କୀ କ'ଣ ?

A.  ଡ଼ି ଲି ଟ

B.  ବ୍ୟାକସ୍ପେସ

C.  Ctrl+Del

D.  Ctrl + Shift + Del

✓

Q90 Computer
ଏକ ନୂ ତନ ୱାର୍କ ବୁ କକୁ  ଏକ୍ସେଲରେ ସେଭ କରି ବା ପୂ ର୍ବ ରୁ  ଏହାର ଡି ଫଲ୍ଟ  ନାମ କଣ ଅଟେ?

A.  Sheet1

B.  Book1

C.  Workbook1

D.  Newdocument
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Reasoning

✓

Q91 Reasoning
A, B, C, D, E, F ଏବଂ G କେନ୍ଦ୍ରକୁ  ମୁ ହଁ  କରି  ଏକ ବୃ ତ୍ତାକାର ଟେବୁ ଲ ଚାରି ପାଖରେ
ବସି ଛନ୍ତି  । B ଙ୍କ ଠି କ ଡାହାଣ ପାର୍ଶ୍ୱ ରେ A ବସି ଛନ୍ତି  । C ଙ୍କ ଠି କ ବାମ ପାର୍ଶ୍ୱ ରେ D ବସି ଛନ୍ତି  । E
ଙ୍କ ଠି କ ଡାହାଣ ପାର୍ଶ୍ୱ ରେ D ବସି ଛନ୍ତି  । B ଙ୍କ ଡାହାଣ ପାର୍ଶ୍ୱ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ F ବସି ଛନ୍ତି  । A ଙ୍କ
ବାମ ପାର୍ଶ୍ୱ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ G ବସି ଛନ୍ତି  ।

G ଙ୍କ ଡାହାଣ ପାର୍ଶ୍ୱ ରୁ  ଗଣନା କଲେ G ଓ E ଙ୍କ ମଧ୍ୟରେ ମୋଟ କେତେ ଜଣ ବ୍ୟକ୍ତି  ବସି ଛନ୍ତି ?

A.  1

B.  2

C.  3

D.  4

✓

Q92 Reasoning
ମୁ ନ୍ନା ବି ନ୍ଦୁ  A ରୁ  ଆରମ୍ଭ କରି  ଉତ୍ତର ଦି ଗକୁ  43 km ଗାଡି  ଚଲାନ୍ତି  । ତା' ପରେ ସେ ଡାହାଣ
ମୋଡ଼ ନେଇ 51 km ଗାଡି  ଚଲାନ୍ତି  ସେ ପୁ ନର୍ବା ର ଡାହାଣ ମୋଡ଼ ନି ଅନ୍ତି  ଏବଂ 52 km ଗାଡି
ଚଲାନ୍ତି  । ଏହାପରେ ସେ ଡାହାଣ ମୋଡ଼ ନେଇ 56 km ଗାଡି  ଚଲାନ୍ତି  । ସେ ଶେଷ ଡାହାଣ
ମୋଡ଼ ନି ଅନ୍ତି , 9 km ଗାଡି  ଚଲାଇ ବି ନ୍ଦୁ  P ରେ ଅଟକି ଯାଆନ୍ତି  । ବି ନ୍ଦୁ  A ରେ ପୁ ନର୍ବା ର
ପହଞ୍ଚି ବା ପାଇଁ  ସେ କେତେ ଦୂ ର (ସର୍ବ ନି ମ୍ନ  ଦୂ ରତା) ଏବଂ କେଉଁ  ଦି ଗକୁ  ଗାଡି  ଚଲାଇବା
ଉଚି ତ? (ଯଦି  ଦି ଆଯାଇ ନାହିଁ ତେବେ ସମସ୍ତ ମୋଡ କେବଳ 90° ଅଟେ ।)

A.  3 km ପୂ ର୍ବ  ଦି ଗକୁ

B.  4 km ପଶ୍ଚି ମ ଦି ଗକୁ

C.  5 km ପୂ ର୍ବ  ଦି ଗକୁ

D.  6 km ପଶ୍ଚି ମ ଦି ଗକୁ

✓

Q93 Reasoning
ଯଦି  '+' ଏବଂ '–' କୁ  ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ ଏବଂ '×' ଏବଂ '÷' କୁ
ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ତେବେ ନି ମ୍ନ ଲି ଖି ତ ସମୀକରଣରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ (?)
ସ୍ଥାନରେ କ'ଣ ହେବ?
88 + (56 × 8) ÷ 4 - 19 = ?

A.  68

B.  79

C.  84

D.  92

✓

Q94 Reasoning
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ଦୁ ଇ ଯୋଡ଼ି  ସେଟ ଅନୁ ସରଣ କରୁ ଥି ବା ଶୈ ଳୀ ଭଳି  ସମାନ ଶୈ ଳୀ
ଅନୁ ସରଣ କରୁ ଥି ବା ଯୋଡ଼ି  ଚୟନ କର । ଉଭୟ ଯୋଡ଼ି  ସମାନ ଶୈ ଳୀ ଅନୁ ସରଣ କରନ୍ତି  ।
HQV : JUU
LPX : NTW

A.  PUR : RYQ

B.  FTH : HXF

C.  MVO : OYN

D.  WIJ : YMH

✓

Q95 Reasoning
ଦତ୍ତ ଅନୁ କ୍ର ମକୁ  ତର୍କ ସି ଦ୍ଧ ଭାବେ ସଂପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ଅକ୍ଷର-
ସଂଖ୍ୟା ଗୋଷ୍ଠୀଟି  ପ୍ର ଶ୍ନ ବାଚକ ଚି ହ୍ନ (?) ସ୍ଥାନରେ ରହି ବ?

KAC 14 IBE 1 GCG -12 EDI -25 ?

A.  CEK-38

B.  NJK-32

C.  GHT-67

D.  VFG-43

✓

Q96 Reasoning
B, C, D, E, G, H ଏବଂ I ଙ୍କ ମଧ୍ୟରୁ  ପ୍ର ତ୍ୟେକଙ୍କର ସୋମବାରରୁ  ଆରମ୍ଭ ହୋଇ
ରବି ବାରରେ ଶେଷ ହେଉଥି ବା ଗୋଟି ଏ ସପ୍ତାହର ଭି ନ୍ନ ଭି ନ୍ନ ଦି ନରେ ଫ୍ଲା ଇଟ ଅଛି  । D ପୂ ର୍ବ ରୁ
କେବଳ B ର ଫ୍ଲା ଇଟ ଅଛି  । E ଓ H ଙ୍କ ମଧ୍ୟରେ କେବଳ ତି ନି  ଜଣଙ୍କର ଫ୍ଲା ଇଟ ଅଛି  । H
ପୂ ର୍ବ ରୁ  କୌଣସି  ଏକ ଦି ନ ଏବଂ I ପରେ କୌଣସି  ଏକ ଦି ନ G ର ଫ୍ଲା ଇଟ ଅଛି  । C ଓ D ଙ୍କ
ମଧ୍ୟରେ କେବଳ ତି ନି  ଜଣଙ୍କର ଫ୍ଲା ଇଟ ଅଛି  । E ପରେ କେତେ ଜଣଙ୍କର ଫ୍ଲା ଇଟ ଅଛି ?

A.  ଚାରି

B.  ତି ନି

C.  ଦୁ ଇ

D.  ଏକ

✓

Q97 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ ଭାଷାରେ,
A @ B ର ଅର୍ଥ  ‘A B ଙ୍କ ବାପା ଅଟନ୍ତି ’
A & B ର ଅର୍ଥ  ‘A B ଙ୍କ ପତ୍ନୀ ଅଟନ୍ତି ’
A # B ର ଅର୍ଥ  ‘A B ଙ୍କ ପୁ ଅ ଅଟନ୍ତି ’
A % B ର ଅର୍ଥ  ‘A B ଙ୍କ ମା' ଅଟନ୍ତି ’

ଉପୋରକ୍ତ ଆଧାରରେ, ଯଦି  ‘P # Q % R & S @ T’ ହୁ ଏ, ତେବେ P ସମ୍ପର୍କ ରେ T ଙ୍କର
କ'ଣ ହେବ?

A.  ବାପାଙ୍କ ବାପା

B.  ପତ୍ନୀଙ୍କ ବାପା

C.  ମା'ଙ୍କ ଭାଇ

D.  ମା'ଙ୍କ ବାପା

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q98 Reasoning
ପ୍ର ଦତ୍ତ ବି ବୃ ତି  ଓ ନି ଷ୍କର୍ଷ ଗୁ ଡି କୁ  ଧ୍ୟାନର ସହି ତ ଅଧୟନ କରନ୍ତୁ । ଏହା ସାଧାରଣତଃ
ଜଣାଶୁ ଣା ତଥ୍ୟ ଠାରୁ  ଭି ନ୍ନ ମନେହେଲେ ସୁ ଦ୍ଧା ବି ବୃ ତି ରେ ପ୍ର ଦତ୍ତ ତଥ୍ୟ କୁ  ସତ୍ୟ ବୋଲି
ବି ବେଚନା କରନ୍ତୁ ଏବଂ ପ୍ର ଦତ୍ତ ବି ବୃ ତି  (ଗୁ ଡି କୁ ) କୁ  ତର୍କ ସଙ୍ଗତ ଭାବରେ କେଉଁ  ନି ଷ୍କର୍ଷ
(ଗୁ ଡି କ) ଅନୁ ସରଣ କରୁ ଛି  ତାହା ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

ବି ବୃ ତି : କି ଛି  ମେସି ନ ଆଙ୍କର ଅଟେ । କି ଛି  ଆଙ୍କର ଚକ ଅଟେ ।
ନି ଷ୍କର୍ଷ  (I): କି ଛି  ମେସି ନ ଚକ ଅଟେ ।
ନି ଷ୍କର୍ଷ  (II): ସମସ୍ତ ଚକ ଆଙ୍କର ଅଟେ ।

A.  ନି ଷ୍କର୍ଷ  (I) କି ମ୍ବା (II) କୌଣସି ଟି  ଅନୁ ସରଣ କରେ ନାହିଁ

B.  ଉଭୟ ନି ଷ୍କର୍ଷ  (I) ଓ (II) ଅନୁ ସରଣ କରେ

C.  କେବଳ ନି ଷ୍କର୍ଷ  (II) ଅନୁ ସରଣ କରେ

D.  କେବଳ ନି ଷ୍କର୍ଷ  (I) ଅନୁ ସରଣ କରେ

✓

Q99 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ଅକ୍ଷର ପୁ ଞ୍ଜ ମଧ୍ୟରୁ  ତି ନୋଟି  ଏକ
ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ ଟି
ସେହି  ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ  ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ )

A.  XRD-ONC

B.  QSF-HQE

C.  LHY-CDX

D.  VPL-MLK

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । (ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକ-ଅଙ୍କ
ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ । ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ  କରାଯି ବ)
(ବାମ) 5 8 1 6 9 3 4 2 5 6 7 4 9 8 3 5 1 7 8 (ଡାହାଣ)
ଏପରି  କେତୋଟି  ପୂ ର୍ଣ୍ଣ  ବର୍ଗ  ଅଛି , ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ଅଯୁ ଗ୍ମ  ଅଙ୍କ ଏବଂ ଠି କ
ପରେ ଏକ ମୌଳି କ ଅଙ୍କ ମଧ୍ୟ ଅଛି ?

A.  1

B.  2

C.  3

D.  4
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